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Learning the User Interface 
The SailWind Router user interface is designed for ease of use and efficiency. SailWind 
Router is designed to meet the needs of the power user, while keeping the beginner in mind. 
SailWind Router's interface and interaction is like other Windows™ applications, including 
SailWind Layout. You can interact with SailWind Router using the keyboard, menus, toolbars, 
and shortcut menus. 

In this lesson: 

 Pointer position display 

 Canceling commands 

 Shortcut menus 

 Panning, Zooming, and Scrolling 

 Selecting objects 

Preparation 

If it is not already running, start SailWind Router and open the file named preview.pcb in the \ 
SailWind Projects\Samples folder. 

Pointer position display 

As you move the pointer around the workspace, its position, in absolute X, Y coordinates 
relative to the origin, appears on the Status Bar in the lower right corner of the screen. 

1. Place the pointer on the design and note the reading on the Status Bar. 

2. Move the pointer around the workspace and note how the X, Y coordinates change as the 
pointer position changes. 

Canceling commands 

You can cancel the current command or sequence at any time by pressing Esc or by right-
clicking and clicking Cancel from the shortcut menu that appears. 

Exception: You cannot use Esc to cancel or stop an autoroute operation. 

Zooming, panning, and scrolling 

Zoom 

Several methods exist for the centering and magnification of a design. In this exercise, you'll 
use the mouse methods: 

 For two-button mouse operations, Zoom on the standard toolbar enables and disables Zoom 
mode. In Zoom mode, the pointer changes to a magnifying glass. 
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 For three-button mouse operations, Zoom mode is always available using the middle mouse 
button. 

 For a mouse with a wheel button, you can combine shortcut keys with the wheel button to 
scroll and to zoom. 

Tip: Pan and Zoom functions are also available using commands on the View menu, using the 
numeric keypad, and using the Windows scroll bars. For more information on Pan and Zoom, 
see the SailWind Router Help. 

Practice Zooming 

1. On the standard toolbar, click the Zoom button  . 

Exception: If you are using a three button mouse, skip this step. 

2. Zoom in. 

 Click and hold the left mouse button in the center of the workspace area you want to 
magnify. 

 Exception: If you are using a three-button mouse, click and hold the middle mouse 
button.  

 Drag the pointer upward, moving the mouse away from you. A dynamic rectangle 
attaches to and moves with the pointer. 

 When the rectangle encompasses the area you want to magnify, release the mouse 
button to complete the operation. 

3. Zoom out. Repeat step 2, but drag the pointer downward, moving the mouse towards you. A 
stationary rectangle, representing the current workspace view, appears with a dynamic 
rectangle, representing the ratio of current zoom level to new zoom level. 

4. Practice using Zoom to adjust the magnification.  

Tip: To reestablish the original view, click the View Board button  on the standard 
toolbar. 

5. To end Zoom mode, click the Zoom button on the standard toolbar. 

Zooming with a mouse wheel button 

1. Press and hold Ctrl. 

2. Rotate the wheel button up (away from you) to zoom in. 

3. Rotate the wheel button down (toward you) to zoom out. 

Changing the zoom level in the navigation window 

You can modify the zoom level of the navigation window while in the workspace. 

1. Point to the center of the design in the workspace and press F5. The zoom level increases 
in the navigation window. Press and hold F5 to 
 zoom smoothly. 

2. Point to the center of the design in the workspace and press F6. The zoom level decreases 
in the navigation window. Press and hold F6 to  
zoom smoothly. 
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Panning 

1. Point to the center of the new view and stop moving the pointer. 

2. Press Insert. The area under the pointer in step 1 is now the center of the view. 

Alternative: Click the middle mouse button. You do not need to be in Zoom mode to pan with 
a three-button mouse. 

Smooth scrolling with a three-button mouse 

1. On the Tools menu, click Options. 

2. Click the Global/General tab, and in the Pointer Settings area, select the Pan display with 
pointer movements check box. 

3. Click OK. 

 Result: Move a component or trace to the edge of the screen and the software 
automatically pans in the pointer direction. Smooth scrolling is also enabled.  

Scrolling vertically and horizontally with a wheel button 

1. Rotate the wheel button up (away from you) to scroll up. 

2. Rotate the wheel button down (toward you) to scroll down. 

3. Press and hold Shift. 

4. Rotate the wheel button up to scroll left. 

5. Rotate the wheel button down to scroll right. 

Selecting objects 

You can select any object (such as a component, trace, or net) by positioning the pointer over 
the object and clicking. This is called object-oriented selection. 

Cycle selection 

Selecting a particular object may take a few tries in a crowded area. To eliminate multiple 
selection attempts, you can cycle through all of the objects near a current selection. 

1. Right-click and click Select Anything. 

2. In the workspace, select U1, pin 28. U1 is the large SOIC in the middle, bottom of the board. 
Pin 28 is the top, left pin on U1. 

3. Press Tab, or click the Cycle button  on the standard toolbar, to cycle through all of the 
selectable objects in the vicinity of pin 28.  

4. Stop cycling when you select the item you want. 

 

During designing, you may want to select only specific objects. For example, you may want to 
select only components. Restrict selections using the Selection Filter toolbar. With the 
Selection Filter toolbar, you can specify which design objects are selectable. Items turned off 
in the toolbar cannot be selected. 
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Filter selection 

1. On the standard toolbar, click the Selection Filter button  . The Selection Filter toolbar 
appears just below the standard toolbar. 

2. On the Selection Filter toolbar, click the Anything button  to enable selection of all 
objects. 

3. Click the Components button  to disable component selection. 

4. Point to a component outline in the workspace and try to select it. You cannot select it. 

5. Point to an object other than a component and select it. You can select other objects. 

6. Press Esc to deselect all objects. 

Use selection shortcuts 

If you right-click when no objects are selected, a shortcut menu containing a list of selection 
shortcuts appears. Clicking one of these shortcuts updates the Selection Filter toolbar to 
include only the items enabled in the shortcut menu. 

1. With nothing selected, and the Selection Filter toolbar open, right-click and click Select 
Nets. Note how the Selection Filter toolbar updates to allow net selection only. 

2. Right-click again and click Select Anything. The Selection Filter toolbar updates to allow 
selection of any object (except nets, pin pairs, and path, which are always off by default). 

Selecting all objects of one type 

You can use the Selection Filter toolbar or the selection shortcuts to select all items of one 
object type. 

1. With nothing selected, right-click and click Select Components. 

2. Right-click again and click Select All to select all the components in the design. 

3. Do not save a copy of the design. 

You completed the user interface concepts tutorial. 
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Assigning Constraints 
Design rules include clearance, routing, and high-speed constraints assigned as default 
restrictions for nets, layers, classes, or pin pairs. In addition, you can assign conditional, 
differential pair, decal and component rules.  

In this lesson: 

 Setting default clearance rules 

 Setting default routing rules 

 Setting net clearance rules 

 Creating a net class rule set 

 Setting conditional rules 

Restriction 

This tutorial requires the General Editing and Advanced Rules security options. In SailWind 
Router, click Installed Options on the Help menu to determine whether you can proceed.  

Preparation 

If it is not already running, start SailWind Router and open the file named previewnet.pcb in 
the \ SailWind Projects\Samples folder. 

Setting default clearance rules 

Properties button  > Clearance tab 

With SailWind Router, you can define the SailWind Layout clearance, routing, fanout and pad 
entry constraints for each level of the design rule hierarchy. 

 
 

The Clearance tab contains a matrix of PCB design data. The matrix lets you specify values 
for any or all data types. 
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1. Set a global default clearance value by clicking All in the upper left corner of the clearance 
matrix. A dialog box appears. 

2. Type 8 and click OK. All matrix values change simultaneously. 

3. Click the Routing tab. In the Trace Width area, type 6 in the Minimum box, type 8 in the 
Recommended box, and type 12 in the Maximum box. 

4. Click the Same net tab. Set a global Same Net default clearance value by clicking All in the 
upper left corner of the Object clearance matrix. A dialog box appears. 

5. Type 12 and click OK. All matrix values change simultaneously. 

6. To save the changes, click OK in the Design Properties dialog box. 

Setting default routing rules 

Properties button  > Layer Biasing tab 

To avoid routing on the plane layers, remove them from the selected routing layers as defined 
in the routing rules. The Layer Biasing tab contains a list of selected routing layers. This list 
lets you specify which layers are permitted for routing. 

1. Clear the check boxes in the Allow Routing column for the Power Plane layer to prevent 
routing on the plane layers. The check box for the Ground Plane layer (defined as a CAM 
plane) may have a check in the box but is automatically disabled because of its layer status. 

2. Click OK to close the Design Properties dialog box. 

Setting net clearance rules 

Project Explorer > Net Objects  

You can assign net-specific clearances that take precedence over the default rules previously 
entered. 

1. Double-click on the Net Objects item. Double-click on the Nets item to expand the tree and 
show the list of all nets. 

2. Scroll through the Nets list. Ctrl+click to select nets +5V, +12V, and GND. Right-click and 
click Properties. The three nets are represented by the Net Properties dialog box. 

3. Click the Clearance tab, and set a clearance value by clicking All in the upper left corner of 
the matrix. A dialog box appears. 

4. Type 10 as the global clearance and click OK. 

5. Click the Routing tab. In the Trace Width area, type 10 in the Minimum box, type 12 in the 
Recommended box, and type 15 in the Maximum box. 

6. Click OK to close the Net Properties dialog box and save the changes. 

Setting net clearance rules 

You can create or modify rule sets in the Project Explorer. In this exercise, you'll create a net 
class in the Project Explorer. 
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1. Click the plus sign (+) to the left of Net Objects in the object list. The tree expands. 

2. Click the plus sign (+) to the left of Nets in the Net Objects tree. The Nets branch expands to 
show all nets in the design. 

3. Scroll through the list of nets and select net A00. Do not expand the A00 branch. Note how 
the net is also selected in the workspace. 

4. Scroll through the list, press Shift, and click net A14 to select the set of address line nets.  

5. Drag and drop to copy the selected nets to the Net Classes branch of the Net Objects tree. 

Tip: Since the Net Classes branch is not visible in the Project Explorer, drag your selection 
to the top of the Project Explorer to force the list to scroll. This lets you drop the selection in 
the Net Classes branch. The branch expands and you can see that you have created net 
class Class1. 

Renaming a net class 

If you do not want to use the default assigned name, you can rename the net class. 

1. Select the Class1 net class. 

2. Right-click and click Rename. The Class1 name is highlighted, and you are in an edit mode. 

3. Type Address and press Enter to rename the net class. 

Setting conditional rules 

Conditional design rules are rules that come into play when objects meet certain conditions 
such as when a net is routed near another net or other design object. A conditional rule is 
most often used when two nets are routed in close proximity to avoid adverse effects on the 
circuitry like crosstalk. An example might be the Underwriters Laboratories (UL) requirement 
of segregating primary, secondary, and ground nets when alternating current is directly 
connected to the PCB. You can assign conditional rules between most components of the 
design rule hierarchy. Conditional rules can exist between nets, nets and classes, classes and 
classes, nets and layers, and so on. 

Creating a conditional rule 

You can create or modify design objects in the Project Explorer. In this exercise, you'll create 
a conditional rule in the Project Explorer. 

1. In the Nets branch of the Net Objects tree, select net +5V.  

2. Do not expand the +5V branch. Note how the net is also selected in the workspace. 

3. Ctrl and click net +12V. Then right-click and click Copy. 

5. Scroll down, point to Conditional Rules, right-click and click Paste. 

6. Double-click to expand the Conditional Rules branch. You can see that you created the 
conditional rule +5V : +12V (All layers). 

See also: "Creating secondary object groups" in SailWind Router Help 
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Assigning a conditional rule 

1. Click the conditional rule +5V : +12V (All layers) to select the rule. 

2. Right-click, click Properties.  

Result: The Clearance tab dialog box for the selected nets appears. The existing value 
boxes appear yellow because the nets already have non-default net rules set in a previous 
step. 

3. Set a global clearance value by clicking All in the upper left corner of the matrix. A dialog 
box appears. 

4. Type 25 as the global clearance and click OK. 

5. Click OK to close the Conditional Rule dialog box. 

6. Do not save a copy of the design. 

You completed the defining design rules tutorial. 
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Preparing a Design 
Prior to a routing session in SailWind Router, you can set up your design environment for the 
current session and save the settings for future sessions. 

In this lesson: 

 Pre-routing procedures 

 Changing the color of items 

 Defining a layer pair 

 Setting the default routing angle 

 Setting a routing grid and a via grid 

 Enabling real width display 

 Setting auto-panning  

 Setting guard bands 

 Saving the default settings 

Preparation 

If it is not already running, start SailWind Router and open the file named previewplaced.pcb 
in the \ SailWind Projects\Samples folder.  

Pre-routing Procedures 

Before you begin routing, you need to perform a few pre-routing procedures. The procedures 
vary by individual and by design. The following preparatory steps are designed specifically for 
this tutorial. It is recommended you follow these steps to receive the full benefit of the tutorial. 

Changing the color of items 

Options button  > Colors tab 

To improve visibility and reduce screen clutter when you route traces, disable the display of 
items not required for interactive routing. 

1. Clear layer check boxes for the Power and Ground plane layers to disable the display of 
these plane layers. 

2. Click the background color, black, in the Color selection area. 

3. Click Background in the general options area to display the background as black.  

4. In the general options area, click items in the Ref. Des., Keepout, Top Outl, and Bot Outl 
columns to make these items invisible. 

5. Click light green in the Color selection area. 

6. Click Connection in the general options area to display the connections as light green. 

7. Leave the Options dialog box open in preparation for the next topic. 
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Tip: With SailWind Router you can save color arrangements to reuse them in other designs. 
After you finish assigning colors to items in the Colors tab, you can save the color 
arrangement. In the Color scheme area of the Colors tab, click Save as, provide a name for 
the new color scheme and click OK. 

Defining a layer pair 

Options button  > Routing/General tab 

Defining a routing layer pair minimizes the amount of time spent on manual layer changes 
during interactive routing. Pairing routing layers limits layer changes to the members of the 
layer pair. For this four-layer design, the obvious routing pair is made up of the Primary and 
Secondary Component layers. 

1. In the Layer Pair area, click Primary Component Side in the First layer list, and click 
Secondary Component Side in the Second layer list. 

2. Leave the Options dialog box open in preparation for the next topic. 

Setting the default routing angle 

Options button  > Routing/General tab 

The trace routing angle setting determines the allowed routing angle (in degrees) of adjacent 
trace segments as they are introduced during interactive routing.  

There are three trace routing angle settings: 

Routing angle Description 

Diagonal Adjacent trace segments are limited to 45-degree intervals. 

Orthogonal Adjacent trace segments are limited to 90-degree intervals. 

Any Angle Adjacent trace segments are not limited to any angle. 

 
For the purpose of this tutorial, set the Routing Angle to Orthogonal. 

1. In the Routing Angle area, click Orthogonal. 

2. Click OK to close the Options dialog box. 
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Setting a routing grid and a via grid 

Properties button  > Grid tab 

In this lesson, use a routing and via grid to facilitate the learning process.  

Set a routing grid and via grid to 8.33 mils to accommodate the 8 mil trace and 8 mil space 
requirements of the design as follows: 

1. Set the X Increment and Y Increment values for the Routing and the Via grids to 8.33. 

2. Click OK to save the settings and close the Design Properties dialog box. Otherwise you 
can use shortcut keys to set the grids. 

3. Using the Grid shortcut key, type gr 8.33 and press Enter to set the 
Routing grid. 

4. Type gv 8.33 and press Enter to set the Via grid. 

Enabling real width display 

Options button  > Global/General tab 

You can enable or disable true width display to see trace widths in their  
real width.  

1. In the Display settings area, type 8 in the Minimum line width box. 

2. Click Apply to activate the setting. 

3. Leave the Options dialog box open in preparation for the next topic. 

Setting auto-panning  

Options button  > Global/General tab 

During a routing session, it may be convenient to pan around the design. SailWind Router 
contains an auto-panning feature that automatically pans the screen following the pointer. 

1. In the Pointer settings area, select the Pan display with pointer movements check box to 
enable the auto-panning feature. 

2. Click OK to close the Options dialog box. 

Setting guard bands  

Options button  > Global/General tab 

During interactive routing and editing, SailWind Router can display guard bands around all 
objects to indicate clearance boundaries. As the pointer approaches objects, visible outlines 
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appear around nearby objects to indicate the clearance boundaries for rules in effect for the 
current operation. 

 

1. In the Display settings area, select the Show guard bands on object 
check box. 

2. Click OK to apply the setting and close the Options dialog box. 

3. Do not save a copy of the design. 

You completed the pre-routing procedures tutorial. 
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Placing Components 
SailWind Router contains many commands for editing component placement within a design. 

In this lesson: 

 Placement toolbar 

 Setting the move origin 

 Pre-placement procedures 

 Placing components using move 

 Placing components using the Project Explorer 

 Experimenting with placement tools 

 Changing placement properties 

Restriction 

This tutorial requires the General Editing and Dynamic Route Editing security options. In 
SailWind Router, click Installed Options on the Help menu to determine whether you can 
proceed.  

Preparation 

If it is not already running, start SailWind Router and open the file named previewrules.pcb in 
the \ SailWind Projects\Samples folder.  

Placement toolbar 

The SailWind Router Placement toolbar contains buttons that represent the component 
placement commands available in SailWind Router. 

To open and close the Placement toolbar: 

 On the standard toolbar, click the Placement button  . 

Setting the move origin 

Options button  > Global/General tab 

SailWind Router enables you to choose between three origins for moving objects.  

These origins include: 

Origin Location 

By Cursor Location The location of the pointer at the time you initiate a component 
move. 
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By Origin The actual component origin as defined in the PCB. 

By Mid-Point The center of the component, calculated by finding the center 
point of a rectangular box that encompasses the part outline 
and its pins. 

 
For the purpose of the exercises below, you will set the move-by mode to Move By Origin. 

1. In the Object movement area, click Origin in the Move object by list. 

2. In the Drag object using list, make sure that Drag and attach is selected. 

3. Click OK to apply the changes and close the Options dialog box. 

Changing placement properties 

You can view and modify various placement details related to a part using the Properties 
command. 

1. With nothing selected, right-click and then click Select Components. 

2. Select a component. With the component selected, right-click and click Properties. The 
Component Properties dialog box appears. 
Alternative: Double click on the component to open the Properties dialog box. 

3. Click the Component tab to display the properties for the selected component. 

4. To change component properties such as location, orientation, and board side, edit the data 
in the related box and click Apply. 

Requirement: Design Rules Checking (DRC) will prevent a component from being placed in 
an illegal location. To turn off checking, type DRC and then Enter. 

5. Experiment with changing the orientation or location of a few components using the 
Component Properties tab. 

6. When finished, click OK to close the Component Properties dialog box. 

7. Do not save a copy of the file. 

Pre-placement procedures 

There are several procedures you must complete before you begin to place parts. 

Set a component placement grid 

1. If it is not already running, start SailWind Router and open the file named 
previewdispersed.pcb found in the \ SailWind Projects\Samples folder.  

2. Set the Component grid to 50 mils by using the shortcut key gc50. Type gc. As you type, the 
Command Argument dialog box appears. Complete the command by pressing the 
Spacebar, typing 50, and pressing Enter. 

3. Set the Display grid to 50 mils by using the shortcut key gd50. Type gd. As you type, the 
Command Argument dialog box appears. Complete the command by pressing the 
Spacebar, typing 50, and pressing Enter. You may not be able to see the Display grid at 
the present viewing scale. If you want to see it, just zoom in. 
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Set the net colors 

View menu > Nets 

To aid in the placement and correct orientation of decoupling capacitors, assign a color to the 
+5V net. 

1. In the Net list area, expand Net Objects. 

2. Expand the Nets branch. 

3. In the Nets list, click +5V. 

4. Click Add to add +5V to the View details area. 

5. In the View details area, click +5V. 

6. Click dark gray in the Palette and then click on the Colors of Pads, Vias, Unroutes box to 
display all component pins and vias connected to +5V as dark gray. 

Set the net visibility 

To help determine the best location for components, temporarily make the plane nets invisible. 

1. With the +5V net selected, clear the Traces check box to make the net invisible. 

2. In the Nets list, click the +12V and GND nets. 

3. Click Add to move them to the View details area. 

4. In the View details area, click the +12V and GND nets and clear the Traces check box to 
make them invisible. 

5. Click OK to apply the visibility settings and close the View Nets dialog box. 

Placing components using move 

In the previous lesson you learned how to configure the Move command for moving and 
positioning components. You will now use this command to place components for the tutorial 
design. The component positions are established to efficiently use your time with the tutorial. 

Tip: Any placement keepouts that may exist in the design are ignored during this section of 
the tutorial because you are working with On-line DRC disabled. If DRC is enabled, you may 
be prevented from placing some of the components in this tutorial. Type DRC and then press 
Enter to disable On-line DRC. 
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Placement locations in this tutorial: 

 

Place the ICs 

Placement toolbar button  > Move button  

Place the ICs and their associated decoupling capacitors first. 

1. When in verb mode, SailWind Router is in a state where the corresponding action is applied 
to each selected object. SailWind Router is in verb mode when a "v" appears as part of the 
pointer. Use this mode whenever you repeatedly move components. 

Alternative: You can also move components outside of verb mode. With verb mode off, 
select the component to move and either: 

 Press Ctrl+E 

 Right-click and click Move. 

 Drag the component to the new location. 

2. Type the shortcut ss and in the Shortcut dialog box press the spacebar and then type u1. 
Press Enter to search and select U1. U1 attaches to the pointer. 

3. Position U1 at X1400, Y800 and click to place it. 

4. Use the shortcut and type ss u2 to search and select U2. 

5. With U2 attached to the pointer, move U2 across the board horizontally and note how the 
nets reconnect as U2 moves. This is called dynamic reconnect. 

6. Position U2 at X1400, Y1450 and click to place it. 

7. Place the following components using the Move command: 

Component X, Y location 

U3 2050 800 

U4 2050 1450 

U5 750 1600 

U6 750 1250 

U7 650 800 
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Place the decoupling capacitors 

1. With Move Component mode active, use the shortcut ss to search and select C1. C1 
attaches to the pointer, but its nets do not appear because the +5V and GND nets are 
invisible. 

2. To place C1 on the opposite side of the board, right-click and click Flip Side. 

Tip: Notice the component outline. Color changes to match the new layer. 

Alternative: Press Shift+F. 

3. Right-click and click Rotate 90 twice. Rotate 90 rotates components 90 degrees 
counterclockwise. Place it under U1 at X1150, Y1000. 

Alternative: Press Ctrl+R. 

4. Repeat the steps above to place the remaining capacitors: 

Capacitor to place X, Y location 

C2 500 1000 

C3 1950 1550 

C4 700 1700 

C5 700 1350 

C6 1950 900 

C10 1150 1650 

Place the Oscillator 

DRC Filter toolbar button  > DRC On/Off button  

Use this same method to locate, select, and move oscillator Y1. Notice the behavior of the 
placement commands when placement keepouts are present. 

Tip: At this point in the tutorial the DRC mode is set to off. To enable placement keepout 
checking, you must change the DRC mode to Prevent. 

1. On the DRC Filter toolbar, click the DRC Settings button. 

2. In the Design Rule Checking dialog box, select the check box in the Enable column for the 
Placement Design Rule, and then select Prevent in the Error Response list. 

3. Click Close to close the DRC Settings dialog box and save the settings. 

4. With Move Component mode active, use the shortcut ss y1 to search and select Y1. Y1 
attaches to the pointer. 

5. Position Y1 at X2050, Y1100 (between U3 and U4), and click to place it. Notice how you are 
prevented from placing a component with a height attribute that exceeds the allowable 
height in the keepout area. 

6. Rotate Y1 90 degrees by right-clicking and clicking Spin, and then place it at X400, Y1400.  

Tip: To spin the component in coarse radial increments, spin the component with the pointer 
closer to the component origin. To spin the component in fine radial increments, spin the 
component with the pointer further from the component origin. 

Alternative: Press Ctrl+I 
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7. To disable On-line DRC, click the DRC On/Off button  on the DRC Filter toolbar so that 
the button is in the deselected position. 

Tip: On-line DRC operation and behavior is covered in another tutorial. 

Placing components using the Project Explorer 

You can also select and move components using the Project Explorer. With the Project 
Explorer, you can quickly search and locate design components and automatically apply 
commands like Select, Highlight, and Rotate 90. 

Place connector J1 

Placement toolbar button  > Move button  

1. In the Project Explorer, locate the Components object. 

2. Expand the Components object tree. 

3. Scroll through the Components list. Click to select J1. 

4. Right-click in the design area and click Flip Side. Click at X1650, Y400 to place J1. 

Place capacitor C7 on the secondary component side 

1. In the Project Explorer, scroll through the Components list. Click to select C7. 

2. Right-click in the design area and click Flip Side. 

3. Rotate C7 180 degrees by pressing Ctrl+R twice, and place it at X400, Y1550. 

Experimenting with placement tools 

Place transistor Q1 and its filter capacitors C8 and C9 using any of the placement methods 
previously described in this tutorial. Place the components at: 

Component  X, Y location 

Q1 3100 1200 with a rotation of 90 degrees 

C8 2100 400 

C9 2100 1800 

R1 2050 550 

R2 2050 1200 

R5 400 1700 

When you finish, do not save a copy of the design. 

You completed the component placement tutorial. 
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Creating Traces with Interactive Routing 
SailWind Router features a comprehensive selection of interactive routing commands. 

In this lesson: 

 Routing interactively 

 Routing plane nets 

 Using the On-line Design Rule Checking modes 

 Routing with keepouts and cutouts 

Restriction 

This tutorial requires the Dynamic Route Editing, Advanced Rules, and General Editing 
security options. In SailWind Router, click Installed Options on the Help menu to determine 
whether you can proceed.  

Preparation 

If it is not already running, start SailWind Router and open the file named 
previewpreroute.pcb in the \ SailWind Projects\Samples folder.  

Routing interactively 

The interactive router is the core trace editing function in SailWind Router. Many of the 
operations for defining traces in the trace editor resemble similar operations in SailWind 
Layout, such as those used for creating polygons and line items. This should minimize your 
SailWind Router learning curve by letting you apply the same skills to many areas. 

In SailWind Router, all connections are converted to traces by selecting the connection and 
creating new corners and layer changes using mouse actions and keyboard combinations. 

Resizing the view 

1. In the Project Explorer, locate the Nets object. 

2. Expand the Nets branch inside the Net Objects tree. 

3. Scroll through the Nets list. Click the net 24MHz to select (and temporarily highlight) the net 
in the workspace. 

4. Zoom into the upper left corner of the design, to center the view around the short portion of 
the 24MHz net, connecting the oscillator to the resistor. 

5. Deselect the net 24MHz by clicking in a blank area of the workspace. 

Start routing 

1. With nothing selected, right-click, and click Select Traces/Pins/Unroutes. 

2. On the standard toolbar, click Primary Component Side in the Layer list to set it as the 
current layer. 
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3. Click the oscillator pad connected to the net 24MHz. 

4. Right-click and click Interactive Route. The beginning of a new trace segment attaches to 
the pointer. 

Tip: At this point, DRC mode is off. New trace segments are not prohibited from shorting to 
other objects. If DRC is enabled, disable it at this time by typing DRC and then Enter. 

5. Move the pointer around and note how one end of the connection attaches to the end of a 
new trace segment and the other end remains attached to the end point of the connection. 
This helps you determine where you are going as you route. 

6. To add corners, click. 

7. To delete corners, press Backspace. 

On nets with more than one connection, the end point of the connection automatically snaps 
to the nearest pin of the net. Experiment with the reconnect by moving the pointer toward the 
lower left corner of the board. Once the end point of the trace segment is closer to U7, it 
detaches from its current end point and snaps to U7. Move the pointer toward the upper left 
and the trace segment snaps back. This feature lets you reconnect traces on-the-fly while 
routing, avoiding the need to manually reorder connections. 

Tip: At any point in this exercise, you can exit the routing command operation by pressing 

Esc. You can also click the Undo button  to undo any actions. 

Changing the routing angle mode 

New segments are constrained to 90-degree increments from the origin of the trace segment 
because the current trace angle mode is Orthogonal. You can change the trace angle mode 
during routing by clicking commands on the shortcut menu. 

 While the trace is attached to the pointer, right-click, point to Routing Angle, and click 
Diagonal. Once you change the angle mode, move the pointer around. Notice how new 
segments are now constrained to 45-degree increments. 

Adding vias and changing layers 

Change layers the same way you add corners, except press Shift when you click. You can 
initiate layer changes at the current pointer location or at the last corner location while routing. 

To initiate a layer change at the current pointer location: 

 With a new trace segment attached to the pointer, use Shift+click where you want to 
change layers. A new via is added at the click location. The second layer of the routing layer 
pair is now the current layer. 

Alternative: With a new trace segment attached to the pointer, click to add a corner. Right-
click, point to Layers, and select a layer from the list. If you don't first add a corner, the trace 
segment attached to the pointer will change layers instead of adding a via and changing 
layers. 

To initiate a layer change at the last corner location: 

1. Click to add a new corner. 
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2. Move the pointer away from the new corner, right-click and click Layer Toggle. A via is 
added to the last corner added. 

Tip: If DRC is enabled, vias are not added if the last trace corner is located inside a 
component pad. 

Changing via type 

If more than one via type has been defined within the design, you can change via types while 
routing. When you start routing a net, SailWind Router will route using the default via type. To 
use a different via type while routing a particular net, use the Via Type option on the shortcut 
menu to choose another via type. 

Changing trace width 

New trace segments are routed at the default recommended trace width specified for the net. 
If a different minimum and/or maximum value has been specified for the net, you can change 
the trace width during routing by clicking commands on the shortcut menu. 

1. While the trace is attached to the pointer, right-click, point to Width, and select a new width 
from the list. Choices include the values specified for Minimum, Recommended, and 
Maximum width for the net.  

2. If the width value you want is not in the list, click Set and enter a value in a range between 
the Minimum and Maximum values specified for the net. The trace width will change to this 
value and this new value will be added to the list. 

Once you change the trace width, move the pointer around. Notice how new segments are 
now added at the newly specified width. 

Ending versus completing traces 

In SailWind Router, you can elect to partially complete or end a trace in almost the same 
manner as adding corners and adding vias.  

 To end a trace, Ctrl+click where you want the trace to end. 

Completing traces 

You can complete a trace in two ways. Use the Complete command or position the end of the 
trace segment over its destination and click the left mouse button. 

 

See also: "Ending traces" in SailWind Router Help 
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Complete a trace locally, without using the Complete command 

 With a trace segment attached to the pointer, define a trace pattern from its start point to its 

end point and click the left mouse button when the complete symbol  appears. The new 
trace is completed, in many instances without need of smoothing or cleaning up the trace. 

Complete a trace using the Complete command remotely remote 

 With a new trace segment attached to the pointer, right-click and click Complete. You can 
also double-click the left mouse button to complete the trace. The new trace is completed 
from its start to its destination. 

Practice routing the short connection of the net 24MHz to completion. 

Tip: At any point in this exercise you can exit the routing command operation by pressing Esc. 

You can also click the Undo button  on the standard toolbar to undo any actions. 

Adding traces with arcs during an interactive routing operation 

1. Begin interactively routing by selecting an unroute and pressing F3. 

2. With a new trace segment attached to the pointer, right-click, point to Arc, and then click 
Add Arc. 

Alternative: Press Alt+A. 

3. Click at the point where you want to end the arc. SailWind Router returns to the normal 
interactive routing mode allowing you to finish routing the trace. 

Tip: If you want to specify the exact radius of the arc, set the radius by typing RAD and 
entering the radius to use. Then while interactively routing, right-click, point to Arc, and click 
Add Arc of Radius. 

Deleting traces and trace segments 

1. With nothing selected, right-click and click Select Anything. 

2. Click a segment of a completed trace and press Backspace. 

3. Click the Undo button  from the standard toolbar to undo the deletion. 

4. Use Shift+click to select the whole pin pair. 

5. Press Backspace to unroute the pin pair. 

Undo/Redo 

SailWind Router allows multiple Undo/Redo operations. Use the Undo and Redo buttons on 
the standard toolbar to remove or redo command operations as needed. 
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Deleting all routing 

At any point in this exercise, you can delete all of the current routing by selecting all of the 
nets and then pressing Backspace. 

1. With nothing selected, right-click and click Select Nets. 

2. Right-click and click Select All to select all nets. 

3. Press Backspace. 

Routing plane nets 

For a typical PCB with embedded planes and surface mounted parts, plane net routing is 
limited to routing a small segment out of the pad and terminating it with a via to provide 
contact with the internal plane. 

Before you begin routing plane nets, you need to update the visibility of the plane nets. 

Update the net visibility 

View menu > Nets 

During the placement stages of this tutorial, the display of certain plane nets was disabled to 
get a clear view of the components during placement. 

Before you can route the plane nets, you need to enable the display of those nets. 

1. In the View details area, select net GND. 

2. In the View details area, select the corresponding Traces check box to display this net. 

3. Select All except connected to plane to limit the display of the nets to only the routed 
portions of the nets. 

4. In the View details area, use Ctrl+click to select the Default, +5V, and  
+12V nets. 

5. In the View details area, clear the corresponding Traces check boxes to disable the display 
of these nets. 

6. Click OK to apply the changes and close the View Nets dialog box. 

End via modes 

To avoid using a layer change and end command to make every plane connection, you can 
set an end via mode that always ends routes with a via. The three end modes are: 

End mode Description 

End No Via Traces end without a via at the end point of the trace. 

End Via Traces end with a via at the end point of the trace. 

End Test Point Same as End Via but the via is also a test point. 
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To change the end via mode: 

1. Start routing interactively, and with a trace segment attached to the pointer, right-click, point 
to End Via Mode, and click End Via. A check mark indicates the current mode. 

2. Find a convenient location for the via and Ctrl+click to create a pin escape to the plane.  

Routing plane nets 

Using the routing commands from the previous exercise, experiment with routing net GND 
using Ctrl+click to end the routes. Note the presence of the plane thermal indicator (an X on 
the via) each time you end a portion of the GND net. This indicates eligibility for a thermal 
relief; it will make contact with  
the plane. 

Routing using On-line Design Rule Checking modes 

You can enable real-time design rule checking during placement and routing to ensure that 
your design constraints are maintained throughout the design process. This interactive 
checking is called On-line DRC. You set DRC modes in the DRC Settings dialog box, through 
the DRC Filter Toolbar, or by using shortcut keys. 

There are four modes of DRC operation: 

DRC mode Description 

DRC Off Specifies no checking. Violation of rules during placement and 
routing are allowed. Clearance violations and the intersection of 
traces are also allowed. 

DRC Prevent  Prevents you from creating violations during placement, routing, 
or trace modification. 

DRC Explain Detects potential errors, temporarily suspends operation for you 
to examine the error conditions in the Spreadsheet window. You 
can then continue the operation with the violations or cancel the 
current operation. 

DRC Warn Generates error messages during placement or routing and lets 
you continue. 

Update the net visibility 

View menu > Nets 

Before you can experiment with On-line DRC, you need to update the display of some nets. 

1. In the View details area, select the Default, +5V, and +12V nets. 

2. In the View details area, select the corresponding check boxes in the Traces column to 
enable the display of these nets. 
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3. Click All except connected plane nets to limit the display of the nets to only the routed 
portions of the nets. 

4. Click OK to apply the changes and close the View Nets dialog box. 

Experiment with routing in DRC Prevent mode 

DRC Filter toolbar button  > DRC Settings button  

To enable the DRC Prevent mode for Clearance checking:  

1. In the Design Rule Checking dialog box, select the check box in the Enable column for 
Clearance, and then select Prevent in the Error Response list. 

2. Close the Design Rule Checking dialog box. 

3. Continue routing traces. Notice that violations are not permitted. 

You should also experiment with the Complete command in DRC Prevent mode by double-
clicking to complete traces at various completion points. 

Tip: Routing in DRC Explain mode creates a ToolTip at the pointer explaining violations. To 
enable DRC Explain mode, in the Design Rule Checking dialog box, select Explain in the Error 
Response list. 

Routing with Dynamics 

Powerful dynamic routing features offer an unprecedented level of interactive routing control 
within SailWind Router.  

Routing with dynamics is another powerful interactive routing feature. Instead of indicating 
each trace corner, you simply start routing and move the pointer in the direction in which you 
want the trace to flow. Trace corners are dynamically added as you move the pointer. 

Enabling dynamics 

Options button  > Routing/General tab 

Dynamics can be enabled and disabled as required by the current routing session.  

1. In the Interactive routing area, select the Dynamically route check box. 

2. Click OK to activate the setting and close the Options dialog box. 

Creating traces with dynamics 

1. With nothing selected, right-click and click Select Unroutes/Pins. 

2. Set the angle mode to Orthogonal by typing ao and pressing Enter. 

3. Select net 24MHz at a point close to U7 (bottom of the view), right-click and click Interactive 
Route. A trace dynamically attaches to the pointer. 



 

 

 SailWind Router Tutorial  29 

Alternative: Press F3. 

4. Move the pointer vertically on the board, in the general direction of the destination of the 
connection. Notice how routing interactively with dynamics automatically chooses a path 
around obstacles and creates a trace pattern. 

5. Experiment with dynamics by moving the pointer, with the trace attached, around obstacles. 
Move the pointer closer to the destination of the connection and double-click. Notice how 
dynamics automatically completes the trace and smooths the pattern. 

Tip: At any point in this exercise you can exit interactive routing by pressing Esc. You can 
also click the Undo button from the standard toolbar to undo any actions. 

Tip: To backup a trace with dynamics enabled, slowly back up over the newly created trace 
pattern. 

6. Experiment by routing traces using the commands covered in this section. 

Interactively routing with dynamics in verb mode 

Route Editing toolbar button  > Interactive Route button  

You can avoid the constant selection of F3 or the command from the shortcut menu by 
entering dynamic routing verb mode. 

1. Using dynamic interactive routing, complete several traces.  

2. Change the trace angle to diagonal, by typing ad and pressing Enter. Continue 
experimenting. Try the same exercises with the trace angle set to Any Angle, by typing aa 
and pressing Enter. 

When you are comfortable using interactively routing with dynamics, continue to the next 
section of the tutorial. 

Rerouting with dynamics 

You can also use dynamics to reroute. This command works in dynamic routing verb mode. 

1. Click any trace segment, right-click and click Interactive Route. 

Alternative: Press F3. 

2. Create a new trace pattern and complete it by clicking on any other point in the trace or 
trace segment. Otherwise, use normal trace completion commands when completing on 
component pins and vias during reroute. 

Routing with keepouts and cutouts 

The sample design contains keepouts. In addition, a board cutout has been added to the PCB. 
With DRC prevent enabled, you can't violate these areas during trace editing. 
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Set display colors for keepouts 

Options button  > Colors tab 

Keepouts may have been set to invisible. For the following exercise, turn on the display of 
keepouts. 

1. Click yellow and click Keepouts for the Primary Component Side. 

2. Click pink and click Keepouts for the Secondary Component Side. 

3. Click OK to apply the color settings and close the Options dialog box. 

Via keepouts 

DRC Filter toolbar button  > DRC Settings button  

The sample design contains a via keepout in the J1 connector. Try to add a via to it. If it is not 
the current DRC mode, set DRC Clearance checking to Prevent. 

1. In the Design Rule Checking dialog box, select the check box in the Enable column for 
Clearance, and select Prevent in the Error Response list. 

2. Close the Design Rule Checking dialog box. 

3. Search for J1 pin 25 and select it using the ss shortcut key. Type ss. As you type, the 
Shortcut dialog box appears. Press Spacebar, type j1.25, and then press Enter. The view 
may change depending upon your current zoom level and the center of your current view. 

4. Click the connection to J1.25 and start routing the connection using the Route command 
(F3). 

5. Move your pointer to the left and press Shift+click to add a via in the keepout outline of J1. 
Note the failure to insert the via. 

6. Now move the trace away from the keepout outline and try to insert the via again. Notice 
how the via is permitted outside of the keepout. 

Routing keepouts and board cutouts 

The sample design contains routing keepouts and a board cutout to accommodate the shield 
on the bottom side of the PCB. Try to add traces across the keepout and under the keepout 
area on the bottom of the PCB. If it is not the current DRC mode, set DRC Clearance checking 
to Prevent. 

1. Search for U4 pin 9 and select it using the ss shortcut key. Type ss. As you type, the 
Shortcut dialog box appears. Press Spacebar, type u4.9, and then press Enter. The view 
may change depending upon your current zoom level and the center of your current view. 

2. Click the connection to U4 pin 9 and start routing the connection using the Route command 
(F3). 

3. Move your pointer to the right and attempt to cross the board cutout. 

4. With the new trace attached to the pointer, create a trace pattern up and around the top of 
the cutout.  
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5. Add a via, continue routing, and attempt to add a trace in the keepout area to the right of the 
cutout. Once again, you are prevented. 

Should I route the entire board? 

Completing the routing of the design is optional. It is a good exercise for you to complete the 
routing, but other portions of the tutorial present you with additional tools to help you route the 
design. 

Do not save a copy of the design. 

You completed the adding traces interactively tutorial. 
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Creating High-speed Traces with 
Interactive Routing 

SailWind Router supports the interactive routing of traces with high-speed constraints. High-
speed routing commands and features give you control and flexibility when you route traces. 

In this lesson: 

 Routing to length with the trace length monitor 

 Adding accordions interactively 

 Interactive routing of differential pairs 

 Graphical feedback in the navigation window 

 Defining high speed rules 

 Interactive routing to matched length rules 

 Setting and using component-level rules 

Restriction 

This tutorial requires the Dynamic Route Editing, Advanced Rules, General Editing, High-
speed Routing (manual), and Route security options. In SailWind Router, click Installed 
Options on the Help menu to determine whether you can proceed.  

Preparation 

If it is not already running, start SailWind Router and open the file named 
previewpreroute.pcb in the \ SailWind Projects\Samples folder.  

Routing to length with the trace length monitor 

The trace length monitor is a graphical aid for monitoring trace length. The monitor consists of 
an expanded pointer graphic showing trace length data. When you enable the trace length 
monitor, trace length information for the object being routed appears as part of the pointer 
graphic to help you manage trace length. 

There are two types of pointer graphics for monitoring trace length. One for monitoring traces 
without length rules and another for monitoring traces with length rules. This lesson discusses 
using the trace length monitor for routing traces with length rules. 

See also: "Monitoring trace length" in SailWind Router Help or "Interactively routing with the 
trace length monitor" in the Routing Concepts Guide 
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Enabling the trace length monitor 

Options button  > Global/General tab 

Turn on the trace length monitor in the Global/General tab of the Options dialog box or by 
using the Ctrl+L shortcut command. 

To enable the trace length monitor: 

1. In the Pointer settings area, select the Length monitor check box to enable the trace length 
monitor. 

2. In the Highlighted object display area, select Turning off highlighting in the distinguish 
highlighted objects by list 

3. Click OK to accept any changes and close the Options dialog box. 

Creating a length rule 

Before you can use the trace length monitor, you must create a length rule for a net. In this 
exercise, you'll create a length rule in the Project Explorer. 

1. In the Project Explorer, locate Net Objects.  

2. Expand the Net Objects branch. 

3. Expand the Nets branch to show all nets in the design. 

4. Scroll through the list of nets and select net CLKIN. Do not expand the CLKIN branch. 
Notice that the net is also selected in the workspace. 

5. Right-click and click Properties. 

6. In the Net Properties dialog box, click the Length tab. Select the Restrict length box to 
enable length rules for this net. 

7. In the Minimum length box, type 1000 to indicate that the finished trace must be at least one 
inch long. 

8. In the Maximum length box, type 2000 to indicate that the finished trace must be no longer 
than two inches in length. 

9. Click OK to accept the changes and close the dialog box. 

Now that you have established a length rule for the net, you can monitor adherence to this rule 
as you route. SailWind Router has several ways to monitor length rules. 

Graphics for traces with length rules 

The trace length monitor presents trace length as a goal for traces with length rules. The trace 
length monitor shows key trace length data whenever you are interactively routing. 

When you select any point along a trace (with length rules) and begin interactive routing, the 
trace length monitor updates a bar graph as shown below. The numeric data appears in the 
current system units and updates as you move the trace end point. 

The progress indicator is a vertical 5-pixel wide bar that moves from left to right as the trace 
length increases. As trace length decreases the progress indicator moves from right to left. 
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Tip: Size shown may not be actual size. 

The following length information is presented in the trace length monitor: 

Trace length monitor shows: Which represents: 

Routed Length (Rt) The current length of added trace segments. 

Minimum Length The minimum length rule for the net or pin pair. 

Maximum Length The maximum length rule for the net or pin pair. 

Estimated Length (Et) The estimated length of trace segments and 
remaining Manhattan distance. 

Color indicators 

When a length rule has been assigned, the trace length monitor will display colors to indicate 
the length progress. 

Monitor Colors: 

Color Meaning 

Yellow length monitor Estimated trace length < min trace length rule 

Green length monitor Estimated trace length is between min and max lengths 

Dark green length monitor Estimated trace length is at 90% of max length 

Red length monitor Estimated trace length exceeds max length 

 

Routing traces with the trace length monitor 

Use the trace length monitor to view length information for a trace while you route it. 

1. With nothing selected, right-click and click Select Traces/Pins/Unroutes. 

2. In the standard toolbar, select Primary Component Side in the Layer list to set it as the 
current layer. 

3. Select the pin or the unroute attached to the net CLKIN at the bottom left corner of the 
board.  

Tip: You can use the Project Explorer to locate the net in the design. Find the CLKIN net by 
selecting it in the Nets branch of the Project Explorer.  

Result: The net highlights in the workspace.  

4. Click on the unroute or the pin from which you want to start routing. 
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5. Right-click and click Interactive Route.  

Alternative: Press F3. 

Result: The beginning of a new trace segment attaches to the pointer. The trace length 
monitor appears at the pointer location. 

6. Move the pointer around and notice how the values change in the trace length monitor. This 
helps you determine how close you are to the length you want as you route. 

Notice how the trace length monitor changes color.  

Tip: The color changes are also visible in the Length Monitor tab of the spreadsheet window 
and in the navigation window. 

7. When the trace is an acceptable length, complete the trace. 

Try adding length rules and routing traces with length rules until you are comfortable with the 
techniques. 

See also: "Interactively monitoring with the trace length monitor" in the Routing Concepts 
Guide 

Adding accordions interactively 

When you route traces with length rules, you may have to add additional length to the traces 
in order to meet the length requirements. You can sometimes add length to a trace in a 
defined space by using accordions. 

Accordions are patterns, created with trace elements, that resemble a signal wave. The 
patterns are typically contiguous and do not include layer changes.  

Amplitude and gap define an accordion. Amplitude sets the height of the accordion and gap 
defines the pitch between accordions. This applies to both horizontal and vertical orientations. 
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Setting the accordion gap and amplitude 

Options button  > Routing/Tune tab 

The minimum accordion gap and amplitude settings are defined on the Routing/Tune tab of 
the Options dialog box.  

Use the following method to set the defaults for accordions: 

1. In the Routing to length constraints area, examine the default parameters in the Accordion 
area. 

2. In the Minimum amplitude (times trace width) box, click the up arrow until the value reads 
10.  

Result: This sets the amplitude of the accordion to 10 times the trace width. 

3. In the Minimum gap (times trace to corner clearance) box, click the up arrow until the value 
reads 3.  

Result: This sets the gap of the accordion to 3 times the trace-to-corner clearance. 

4. Click OK to accept the settings and close the Options dialog box. 

Adding accordions  

You use Add Accordion to interactively define accordions. The command is not used to 
complete trace routing and can only be used during interactive routing. You start this 
command during interactive routing by right-clicking and clicking Add Accordion.  

 

 
Using Add Accordion, you can interactively add an interval of an accordion on each mouse 
click in the same way that a mouse click adds a corner during interactive routing. 

After you start Add Accordion, a partial accordion pattern is created and is attached by its end 
point to the pointer. Move the pointer up or down to stretch the amplitude of the accordion and 
click to define the first interval. Repeat the steps to continue defining the accordion. To 
complete the accordion and return to the interactive route command, double-click. 
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Adding an accordion 

 

 

 

Defining the start point for an automatic accordion 

Once you begin Add Accordion, you have several ways to define the accordion. To use 
automatic definition, you simply move the pointer away from the start point of the Add Accordion 
command as defined above. 
You can also define the start of the accordion and maintain the default minimum amplitude. To 
do this, begin Add Accordion and, with the end point of the accordion attached to the pointer, 
click to position the first bend of the accordion. 

 

To add an accordion while routing: 

1. Select the CLKIN net in the Nets branch of the Project Explorer. Right-click in the design 
area and click Unroute. This unroutes the length restricted net that was created earlier in the 
tutorial. 

2. With nothing selected, right-click, and click Select Traces/Pins/Unroutes. 

3. In the Layer list on the standard toolbar, click Primary Component Side to set it as the 
current layer. 

4. Right-click and click Interactive Route to begin routing the net. 

Alternative: Select one of the pins associated with the CLKIN net and press F3.  

Tip: To view trace length while adding accordions, press Ctrl+L to see the trace length 
monitor. 

5. Add a few corners while routing the trace toward an open area of the board.  

6. With the trace still attached to the pointer, right-click and click Add Accordion. 

Tip: Add Accordion inserts a corner at the start point of the accordion. If you try to start an 
accordion at an existing corner location, the command may not start the accordion due to a 
conflict between the corners. For best results, do not start at an existing corner location. 
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7. Drag the pointer in the direction you want. Notice that SailWind Router begins to add 
accordion sections with the default values for gap and amplitude. 

8. Add the number of accordion sections you want, and then double-click to complete the 
accordion. 

Alternative: Right-click and click Complete Accordion.  

9. Route the trace to completion. 

 

See also: “Adding length to traces” in SailWind Router Help. 

Creating custom accordions 

During Add Accordion operations, each click results in the addition of an accordion interval. You 
can combine manual and automatic accordion definition to create customized accordion 
patterns. 
You define the accordion by defining the starting point with a click. Then you create an 
amplitude and define the next point of the accordion with a click then drag the pointer. The 
automatic accordion definition feature is applied. 

 

Tip: Defining a manual accordion does not affect the default accordion assigned in the Routing 
tab of the Options dialog box. The next time you use Add Accordion, the default values apply. 
Practice adding custom accordions and experimenting with setting different amplitudes at 
various locations in the accordion. 
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Interactive routing of differential pairs 

You can use differential pairs routing when you create many high-speed designs. By routing 
certain critical traces as differential pairs you control signal skew, timing windows, and 
susceptibility to interference. 

In order to route differential pair traces, you need to understand the terminology for the various 
features of a differential pair trace. The following graphic shows the various elements of a 
differential pair. 

 

The objective is to route the differential signals from their source pins, around any immediate 
obstacles, and bring them together at a common point (called the gathering point) to begin the 
controlled gap part of the trace. The area between the source pins and the gathering point is 
the start zone. 

The objective at the other end is to bring the controlled gap part of the differential pair trace as 
close as possible to the destination pins (the split point), route around any immediate 
obstacles, and complete the trace. The area between the split point and the destination pins is 
the end zone. 

Shoulder length 

The shoulder length can be either the measured length of a trace from its source pin to the 
gathering point or the measured length of a trace from the split point to its destination pin. 

See also: "Creating differential pair traces" in the SailWind Router Help  

Obstacles 

In general you don't want to route differential pairs around objects such as vias and pins. The 
only exceptions are for pin escape in the start and end zones of  
the trace.  

Tip: Using the Split command, the interactive router can route around obstacles at any time 
and has no restrictions on the number or size of obstacles.  

Creating a differential pair 

1. In the Project Explorer, expand the Net Objects tree. 
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2. Expand the Nets branch to show all nets in the design. 

3. Scroll through the list of nets and select net $$$7651. Do not expand the $$$7651 branch.  

Result: The net is also selected in the workspace. 

4. Scroll through the list, press Ctrl, and click net $$$7652.  

5. Copy and Paste, or drag and drop to copy the selected nets to the Differential Pairs branch 
of the Net tree. 

Tip: This lets you paste, or drop the selection in the Differential Pairs branch. Expand the 
branch and you can see that the differential pair $$$7651<->$$$7652 is created. 

Assigning differential pair rules 

1. Click the differential pair $$$7651<->$$$7652 to select the pair. 

2. Right-click and click Properties. The Differential Pair Properties dialog box appears for the 
selected nets. 

Tip: You can use the Differential Pair Properties dialog box to set the properties for more 
than one pair at a time. 

3. In the Gap between objects when routing box, type 8 to set the routing gap to 8 mils. 

4. In the Length area, type 1500 in the Minimum box to establish a shoulder length minimum 
for the pair of 1.5 inches. 

5. In the Length area, type 2500 in the Maximum box to establish a shoulder length maximum 
for the pair of 2.5 inches 

6. Click OK to accept the changes and close the dialog box. 

Routing the differential pair 

You will now route the differential pair that you just created. 

1. With nothing selected, right-click, and click Select Traces/Pins/Unroutes. 

2. In the Layer list on the standard toolbar, click the Primary Component Side to set it as the 
current layer. 

3. In the Project Explorer, select one of the nets ($$$7651 or $$$7652) in the Nets list.  

Result: The net is highlighted in the workspace.  

4. Select the unroute or the pin from which you want to start routing. 

5. Right-click and click Interactive Route. 

Alternative: Press F3. 

Result: Both members of the differential pair are automatically selected and attached to the 
pointer. 

6. Without clicking, move the pointer around.  

Result: Traces attempt to join together as a pair as soon as they leave their source pins. 

7. Start routing the traces away from the source pins. Click to establish the first corner and 
anchor the pair. 

Result: The traces route on the centerline between the two traces.  

8. Continue to route in the direction of the destination pins. 

9. As you approach the destination pins, right-click and click Complete. 
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Tip: Use the Trace Length Monitor to ensure the nets are within length restrictions otherwise 
the autorouter may choose a different topology to complete the trace within the rules. 
SailWind Router automatically completes both traces of the differential pair and may 
meander its path to ensure length restrictions are met. 

10. Experiment with defining and routing additional differential pairs. When you are comfortable 
with the techniques, continue with the next part of this lesson. 

Route separately 

At times you may want to route differential pairs individually to escape from a connector or 
BGA pins. Using Route Separately you can split the pairs and route each trace separately, 
switch between the traces, and rejoin them to continue routing them as a pair.  

1. Using the Project Explorer, select the $$$7651<->$$$7652 differential pair that you created 
in the previous example. 

2. Once the pair is highlighted in the design, right-click in the design area and click Unroute.  

3. Click the pin or an unroute attached to one of the nets ($$$7651 or $$$7652). 

4. Right-click and click Interactive Route. Both traces of the differential pair are selected and 
attached to the pointer. 

5. Start routing the traces away from the source pins and click to establish the first corner and 
anchor the pair.  

6. Continue to route in the direction of the destination pins. 

7. As you approach the destination pins, right-click and click Route Separately. 

Result: The pointer attaches to the end of one of the traces. 

8. Route the trace for a short distance, add a corner, and then right-click, and click Switch 
Trace.  

Result: The pointer detaches from the current trace and attaches to the end of the other 
differential pair trace.  

9. Route this trace for a short distance and click to add a corner. 

10. Right-click, and click Route Separately to end routing separately and continue routing. 

11. As you approach the destination pins, right-click and click Complete. 

Tip: Use the Trace Length Monitor to ensure the nets are within length restrictions otherwise 
the autorouter may choose a different topology to complete the trace within the rules. 
SailWind Router automatically completes both traces of the differential pair. 
 

You can also use Route Separately to complete pair traces individually at their destination 
pins, such as when finishing the traces at a connector.  

1. Unroute the pair. 

2. Route the pair differentially from the source pins. As you approach the destination pins, 
right-click, and click Route Separately. 

3. With the pointer attached to one trace of the pair, route it to its destination pin. When you 
reach the destination pin, click to complete the trace.  

Result: The pointer automatically attaches to the end of the other trace.  

4. Route the second trace to its destination pin and click to complete the trace. 
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Continue to experiment with the Route Separately command, trying different combinations of 
routing modes to complete differential pairs. 

Adding via pairs 

While routing differential pair traces, you may want to transition layers by using vias. SailWind 
Router inserts pairs of vias when routing differential pairs. 

It is preferable to route differential pair traces without using vias. When you use vias to change 
layers, you should try to keep them in a close, symmetrical pattern and minimize the lengths of 
connecting stubs. When you add vias, they are placed in one of the following patterns: 

 

You can add via pairs to the design in any orientation.  

1. Unroute the pair from the last example. 

2. Start routing the pair as described in the last example. 

3. To add a via pair, right-click and click Add Via.  

Result: A pair of vias is inserted at the pointer location. 

4. To rotate the via pair, right-click, point to Via Pattern, and click a new via pattern. 

5. Continue routing the pair on another layer. Add another via pair to return to the current 
routing layer. 

6. As you approach the destination pins, right-click and click Complete. 

Result: SailWind Router automatically completes both traces of the differential pair. 

Splitting differential pairs 

When routing differential pairs, it is sometimes necessary to split the pair for a short distance 
to route around an obstacle such as a component pin or a via. Use the split command to 
temporarily split the pair and route around an obstacle. 

1. Unroute the pair. 

2. With nothing selected, right-click, and click Select Traces/Pins/Unroutes. 

3. Using the pair in the above example, click the pin or an unroute attached to one of the nets 
($$$7651 or $$$7652). 

4. Right-click and click Interactive Route.  

5. Start routing the traces away from the source pins and add a corner to anchor the pair.  
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6. Continue to route the pair toward a row of component pins so that you can try to route the 
pair between the pins. There is not enough space for the pair to pass between the pins. 
There is, however, enough clearance to pass the traces individually between the pins. 

7. As you approach the pins, right-click, and click Split Trace Segments. Alternative: Shift+X.  

Result: The traces can now split apart like they do when you start a differential pair trace at 
a component. This lets the traces pass around a pin. 

8. Click to end the Split command and return to routing differential pairs. 

9. Route the pair to completion. If you encounter another obstacle, use the Split command to 
pass around it. 

10. As you approach the destination pins, right-click and click Complete. SailWind Router 
automatically completes both traces of the differential pair. 

Tip: The Split command inserts a corner at the split point. If you try to split a pair at an existing 
corner location, it may not split due to a conflict between the corners. For best results, do not 
start the Split command at an existing corner location. 

Experiment with the Split command and try to route around different obstacle types. 

Graphical feedback in the navigation window 

Navigation Window button  

As you route traces with length rules, the Navigation window provides real-time feedback on 
your compliance with net length rules. 

1. Unroute the pair and click the pin or an unroute attached to one of the nets ($$$7651 or 
$$$7652). 

2. Right-click and click Interactive Route.  

3. Start routing the traces away from the source pins and click to establish the first corner and 
anchor the pair. As you begin routing, an image of the traces appears in the Navigation 
window.  

4. Continue to route in the direction of the destination pins. 

5. Move the pointer around and notice how the color of the traces changes in the Navigation 
window. This helps you determine how close you are to achieving the rule length as you 
route. 

6. Notice how the trace image changes color from yellow to green as you approach the desired 
trace length. Also notice that the trace image changes to red if you exceed the maximum 
length. 

7. When the trace is an acceptable length, right-click and click Complete. 

8. Do not save a copy of the design. 

 

The Navigation window provides information similar to the trace length monitor. The 
Navigation window also shows color-coded information during other operations such as 
placement and moving components. This helps you visualize and predict compliance with 
length rules as you position and move components and other design objects. 
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Defining high-speed rules 

SailWind Router supports routing of traces with high-speed rules including length-controlled 
and matched length for nets and pin pairs. These can be defined for individual nets and pin 
pairs or for net and pin pair groups. You can also define routing and clearance rules 
individually for components.  

Interactive routing to matched length rules 

Matched length rules specify a target length and tolerance for a group of nets to match their 
lengths after routing. This task is usually performed by the autorouter, though it can be 
performed manually, one trace at a time. Typically, you can use the Spreadsheet window to 
monitor the length. 

Defining a matched length net group 

You can create or modify design objects in the Project Explorer. In this exercise, you'll create 
a matched length net group rule in the Project Explorer. 

1. Expand the Nets Objects tree. 

2. Expand the Nets branch to show all nets in the design. 

3. Scroll through the list of nets and select net A00. Do not expand the A00 branch. Notice how 
the net is also selected in the workspace. 

4. Scroll through the list, press Shift, and click net A07. 

5. Drag the selected objects to the Matched Length Net Groups branch of the Net Objects tree. 

Tip: If the Matched Length Net Groups branch is not visible in the Project Explorer, drag 
your selection to the top of the Project Explorer, forcing the list to scroll. This lets you drop 
the selection in the Matched Length Net Groups branch.  

6. The branch expands and you can see that a new Matched Length Net Group is created.  

Result: SailWind Router temporarily assigns a default name of MLNetGroup1 to the group.  

7. Type the name AddressBus and press Enter to accept the new name. 

You created a Matched Length Net Group for the first eight signal nets of the address bus. 

Assigning matched length net group rules 

You will now assign the required length rules to the nets in this group: 

1. Select the Matched Length Net Group AddressBus. 

2. Right-click and click Properties.  

Result: The Matched Length Group Properties dialog box for the selected nets appears. 

3. If the default value in the Tolerance box is not set to 200, type 200. This limits the difference 
in routed length between the shortest and the longest nets in this group to 200 mils. 

4. Select the Restrict length check box to enable length restrictions. 

5. Type 2500 in the Minimum length box to establish a minimum length requirement of 2.5 
inches for each net in the group. 
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6. Type 3500 in the Maximum length box to establish a maximum length requirement of 3.5 
inches for each net in the group. 

7. Click OK to accept the changes and close the dialog box. 

Monitoring compliance with matched length net rules 

The Length Monitor tab in the Spreadsheet window provides feedback when interactively 
tuning matched length traces. 

The Length Monitor tab provides a color-coded view of length-controlled nets. It is updated in 
real-time and the fields change from yellow to green and from green to red, indicating each 
net's compliance with the length rules. 

See also: "Length Monitor tab" in the SailWind Router Help 

Setting and using component-level rules 

You can define specific design rules at the component level. These component-level rules let 
you set specific routing requirements on a  
per-component basis. This lets you set special trace width and clearance rules for escaping 
traces from a high-density component, or setting specific pad entry rules for a particular 
connector.  

Setting component-level rules 

To assign component routing and component clearance rules: 

1. In the Project Explorer, expand the Components branch to show all components in the 
design. 

2. Scroll through the Components list. Select U1. 

3. Right-click, click Properties, and click the Clearance tab. The Component Properties dialog 
box for the selected component appears. 

4. Set a global clearance by clicking All in the upper left corner of the matrix. The input 
clearance value dialog box appears. 

5. Type 12 as the global clearance and click OK. This specifies that all clearances related to 
this component will be 12 mils instead of the default used by other components. 

6. Click Apply to accept the changes.  

Result: All affected fields in the dialog box are yellow, indicating that the rules differ from the 
default. A Changed Properties icon appears on the tab. 

7. Click the Routing tab. In the Trace Width area, type 10 in the Minimum box, type 12 in the 
Recommended box, and type 15 in the Maximum box. This specifies that all traces 
connected to this component must observe these larger clearances, at least until the traces 
reach the outline of the part. 

8. Click Apply to accept the changes.  

9. Click the Pad Entry tab. The component pad entry options appear. 

10. In the Enter pads through area, clear all check boxes. This allows traces to exit only straight 
out of the pads on this component. 
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11. Clear the Ignore first corner rules to complete traces when required check box. 

12. Click Apply to accept the changes.  

13. Click OK to close the Component Properties dialog box. 

Try setting component-level rules for various components in the design. Notice that when the 
Component Properties dialog box is open, tabs with component-level rules that differ from the 
default rules have a Changed Properties icon. 

See also: "Setting component properties" in the SailWind Router Help  

Rescheduling nets 

Options button  > Global/General tab  

You can change the distribution of unroutes without returning to SailWind Layout ECO. You 
can override the default length minimization interconnect scheme and specify a particular 
order to interconnect the nets. 

Before rescheduling nets, set the Highlighted Object Display options: 

1. In the Highlighted object display area, click Dimming other object colors in the Distinguish 
highlighted objects by list. 

2. Click Apply to accept the changes.  

3. In the Brightness area, move the slider to the middle of the range between high and low. 
You can preview the results in the workspace area. 

4. Click OK to close the Options dialog box. 

To reschedule a net: 

1. On the Standard toolbar, click the Route Editing button. 

2. On the Route Editing toolbar, click the Reschedule button. 

3. In the Project Explorer, expand the Net Objects tree. 

4. Expand the Nets branch to show all nets in the design. 

5. Click the net A00 to select the net. 

Tip: When you select a specific valid net to reschedule, all other nets in the workspace dim 
in the background to enhance the visibility of the selected net. When you finish rescheduling 
the selected connection, the workspace returns to full brightness until you select the next 
unroute. If you select a net that is invalid for rescheduling, the workspace does not dim and 
rescheduling is not allowed for the selected net. 

6. In the workspace, select the top half of the left-most pin of the net (U6 pin 1).  

Tip: When you hover the pointer over a pin, an in-place query is activated to give you 
information about why a particular pin can or cannot be connected. When the connection is 
available, the pointer changes to a bull's-eye indicating that the connection will be valid if 
completed. 

Result: The net appears highlighted in the navigation window against a gray-scale 
background. When the pin is selected, the original unroute is replaced by a line that goes 
from a pin to the pointer.  
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7. Point to pin 1 of U6. This is the pin to which the unroute was originally connected (End of 
original unroute). 

8. Point to the highlighted pin directly to the right. Pin 10 of U2 is disconnected (Start of 
unroute). 

9. Point to either of the other highlighted pins at the lower part of the board. The pointer 
changes to a bull's eye. 

10. Click one of the pins to reschedule the net connection. 

Tip: When you click a pin to complete the rescheduling process the whole net switches to a 
Protected topology type. The Net Properties dialog box reflects this change and a message 
appears in the Command Window. 

11. Practice rescheduling a few of the other nets in the design, noting the behavior of the pointer 
and the messages that appear. Connect some of them in daisy chain sequences and others 
as star topology arrangements.  

12. When finished, click the Reschedule button on the Route Editing toolbar. 

13. Do not save a copy of the design. 

You completed the adding traces with high-speed constraints tutorial. 
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Autorouting with SailWind Router 
Before autorouting, settings are checked to ensure the autorouter will route to your 
expectations. 

In this lesson: 

 Setting units of measure 

 Setting grids 

 Setting net visibility and length minimization 

 Autoroute options 

 Autorouting by selection 

 Autorouting the design 

Restriction 

This tutorial requires the Advanced Rules, General Editing, and Route security options. In 
SailWind Router, click Installed Options on the Help menu to determine whether you can 
proceed.  

Preparation 

If it is not already running, start SailWind Router and open the file named 
previewpreroute.pcb in the \ SailWind Projects\Samples folder.  

Setting units of measure 

Options button  > Global/General tab 

You can change the unit of measure to inches, mils, or metric units. 

1. The Design units settings are on this tab. Leave the current design units set to Mils. 

2. Click OK to close the Options dialog box. 

Setting grids 

SailWind Router has five working grids, plus a visible grid: 

Grid Purpose 

Display Dot grid used as a visual aid 

Routing Establishes minimum snap distance during routing and editing 

Test Point Establishes spacing and location of test points 

Via Establishes spacing and location of vias 
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Fanout Establishes spacing and location of vias inserted during fanout 
operations 

Component Establishes spacing and location of component origins during placement 
operations 

 
You will set several grids in this tutorial. 

Setting the display grid 

right-click > Properties > Grid tab 

The dots in this grid are just a visual aid. 

1. In the Displayed row, click in the X Increment box. 

2. Type the value you want to use for the Display grid, for example, 50. 

3. Repeat this for the Y Increment box. 

4. To disable the Display grid, set the values in the X Increment and Y Increment boxes to a 
small value, such as 10. It is not actually disabled, but you will not see it unless you zoom in 
significantly. 

Setting the working grids 

The spacing for each grid is individually set on the Design Properties dialog box.  

Tip: To take advantage of the shaped-based architecture of SailWind Router, disable the 
Snap grid in your design. This lets you maintain grid values but SailWind Router ignores them 
during autorouting. 

To turn off snap-to-grid for the design grids: 

1. In the Design Properties dialog box, click the Grid tab. 

2. Clear the check boxes in the Snap Objects to Grid column for the Routing, Test Point, Via, 
and Fanout rows. 

3. Click OK to close the dialog box and apply the changes.  

Setting net visibility and length minimization 

View menu > Nets 

You must make a few updates to the design file to prepare it for proper routing in SailWind 
Router. Before you can route the plane nets, you need to enable plane net display. 

1. Select the check boxes in the Traces column to enable display of the routed portions of the 
following nets: +12V, +5V, and GND. 

2. If necessary, for each of the plane nets, click All except connected to plane to limit the 
display of the nets to only the routed portions. 
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3. Click the color tile in the Colors of Pads, Vias, Unroutes column to turn off the color for the 
+5V net. 

4. Click OK to apply the changes and close the View Nets dialog box.  

Result: The updated display of the nets reveals that the lengths for the plane nets were not 
minimized. 

5. On the Tools menu click Length Minimization to perform a whole board net length 
minimization 

Autoroute options 

There are several options that specify how SailWind Router should autoroute, including the 
routing angle, pad entry quality, fanout pattern, and testability. 

Assigning routing options 

Options button  > Routing/General tab 

You use routing options to specify the routing angle, pad entry quality, and 
miter options. 

1. In the Routing angle area, click Diagonal. 

2. In the Miters area, type 3.5 in the Ratio box, and type 180 in the Angle box. 

3. Click OK to close the Options dialog box and apply the changes. 

Assigning pad entry options 

right-click > Properties > Pad Entry tab 

1. In the Enter pads through area, clear the Any angle box to establish pad entry preferences. 

2. Clear the Ignore first corner rules to complete traces when required box. 

Assigning fanout options 

right-click > Properties > Fanout tab 

Fanout options specify the fanout alignment, spacing, direction, and other settings for the 
fanout pattern. 

1. In the Placement of via fanout for area, select the SOIC/QUAD tab. 

2. In the Alignment list, select Aligned, single row. 

3. In the Direction list, select Both sides. 

4. In the Spacing list, select Use Grid. 

5. In the Create fanouts area, clear the Signal nets and Unused nets boxes. Leave the Plane 
nets check box selected. Leave all of the check boxes in the Allow multiple connection to 
area selected. 
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6. In the Fanout length area, leave the Unlimited box selected. 

7. Click OK to close the Properties dialog box and apply the changes. 

Autorouting by selection 

You can autoroute the entire design or only selected objects. Before you autoroute the entire 
design, you must define how SailWind Router should complete the design by defining a 
strategy. 

SailWind Router has many ways to autoroute a design. You can select components, nets, or 
pins and apply an autorouting pass type to the selected objects (such as Fanout, Route, or 
Optimize), or you can use the Autoroute command to autoroute the entire design. 

To apply pass types to selected objects: 

1. Open the file named previewrouter.pcb found in the \ SailWind Projects\Samples folder.  

2. In the Project Explorer, locate the Components object. 

3. Expand the Components tree to show the list of all components. 

4. Scroll through the Components list. Ctrl+click U1 and U2. U1 and U2 are the large SOICs in 
the center of the design.  

5. With U1 and U2 selected, right-click in the workspace, and click Fanout. 

Result: After a few moments, several component pins are dispersed to vias according to the 
Fanout options previously set. When the command is finished, all selected items are 
deselected automatically.  

Tip: You can also use Fanout, Route, or Optimize pass types in verb mode. Verb mode is a 
state in which you click a command such as Fanout, and then SailWind Router applies the 
currently active command repeatedly to serial selections.  

Autorouting the design 

In addition to autoroute by selection, you can choose to autoroute the entire design at once. 

Defining an autorouting strategy 

Options button  > Routing/Strategy tab 

Before autorouting an entire design, define a routing strategy. You can run one or more of the 
seven pass types on your design. Within the Strategy tab, you can also define the order in 
which to route components or nets. 

To set a routing strategy: 

1. Select which pass types to run by determining what processes are required in your design. 
For this tutorial, in the Pass definition area, click Fanout in the Pass Type column to 
highlight the Fanout pass type so you can set it up to disperse the connections from the 
larger SOICs in the center of the design. There are eight pass types. Each pass type 
performs a specific autorouting function. Each pass contains one or more subpasses. 
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Pass Types: 

Pass Type Description 

Fanout Disperses unroutes from SMD pads using short traces 
connected to a via. 

Patterns Detects unroute patterns and completes them in a Z or C 
pattern. 

Route Completes unroutes. 

Optimize Reviews all trace patterns and attempts to improve the trace 
pattern quality by reducing via usage and overall trace length. 

Center Centers traces between objects such as pins and vias. 

Miters Locates all trace corners of a specified angle and adds a miter 
to the corner. 

Test Point Performs a testability analysis on each net and adds or 
assigns test points as required, goal is to achieve 100% 
testability. 

Tune Adjusts length of nets with minimum, maximum, and matched 
length constraints. 

 
The combination of pass types you use varies per design. For most PCB designs, however, 
the default strategy, which uses the Route and Optimize passes, is sufficient. 

2. Define a routing order to define the specific order in which to route objects or to limit the 
application of a pass type to specific objects. 

a. In the Routing order definition area, expand the Components tree, scroll through the list, 
and select U3. Shift+click U6. U3 through U6 are selected in the design and in the 
object list. 

b. Click Selected to add the components to the Routing Order list. 

c. Select All Nets in the Routing Order list and press the Delete button  to remove All 
Nets from the Routing Order list.  

Result: This excludes all other nets from the fanout operation. 

3. Select the Pass check box for the Fanout pass type to enable the pass. 

4. Click OK to apply the changes and close the Options dialog box. 

Starting Autorouting 

Routing toolbar button  > Start Autorouting button  

You can also press F4 to start autorouting. As each autorouting pass completes, the results 
appear in the Status tab of the command window. 

If the command window isn't open, open it: 

 On the standard toolbar, click the Command Window button. 
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When autorouting completes, a link to a routing report appears in the Status tab of the 
command window. 

Tip: In addition to the rules defined in this tutorial lesson, SailWind Router supports 
autorouting with high-speed rules including minimum, maximum, and matched length, 
differential pairs, and trace tuning with accordions or meanders. 

Using Pause and Resume 

You can pause, resume, or stop the autorouting process at any time during autorouting. This 
lets you review your progress and either stop autorouting to make changes to your strategy or 
continue the current autorouting operation. 

Pause and resume autorouting 

Pause suspends the current autorouting operation. When you resume, the autorouting 
operation continues from where you paused.  

1. During autorouting, click the Pause Autorouting button  on the Routing toolbar. 

Tip: You can set the Pause feature in Tools menu > Options > Strategy tab for each of the 
pass types. 

2. Experiment with zoom to review the current results of autorouting. 

3. On the Routing toolbar, click the Resume Autorouting button  to resume autorouting. 

4. When finished, do not save a copy of the design. 

You completed the autorouting design preparation tutorial. 
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Checking for Design Rule Violations 
The Design Verification command lets you check a design for clearance, connectivity, high-
speed, and plane errors. This advanced space checking is quick and accurate to .00001". 
With the SailWind Router Design Verification command, you can check designs for Clearance 
Rules violations including: 

 Nets against all objects 

 Same net restrictions 

 Minimum/maximum trace width 

 
If you also have optional security features such as SailWind High-speed Routing and DFM, 
additional checks are available including: 

 Net and pin pair length 

 Differential pairs 

 Automatic testing violations 

 Fabrication 

In this lesson: 

 SailWind Router design verification versus SailWind Layout design verification 

 Checking design rules in SailWind Router 

 Checking design rules in SailWind Layout 

Restriction 

This tutorial requires the Verify Design security option. In SailWind Router, click Installed 
Options on the Help menu to determine whether you can proceed.  

Preparation 

If it is not already running, start SailWind Router and open the file named 
previewrouterverify.pcb in the \ SailWind Projects\Samples folder.  

SailWind Router design verification versus SailWind 
Layout design verification 

SailWind Router includes many advanced features including optional high-speed design rules 
support for component rules, via at SMD, differential pairs, and matched length rules. Designs 
using these advanced rules can be checked with the Design Verification command within 
SailWind Router. 

Design verification support for these advanced features does not exist in SailWind Layout; 
however, checking of component rules, via at SMD, differential pairs, and matched length 
rules is accessible from within SailWind Layout. This lets you find and correct design errors 
without going back and forth between SailWind Layout and SailWind Router. 
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Checking design rules in SailWind Router 

Options button  > Design Verification tab 

The Design Verification tools in SailWind Router scan the design database looking for all 
design rule violations. If errors are detected, they are identified with an error symbol and 
itemized in the spreadsheet window. 

Perform a complete clearance check 

1. You can set up design verification using options on this tab. 

Alternatively, click one of the predefined Design Verification schemes in the Design 
verification scheme name list.  

2. You can check the entire design or just the part of the design visible in the workspace. What 
you check is determined by the Conduct checks area.  

If the In visible workspace only box is selected, use the zoom commands to scale the 
design and set the checking area. If the In visible workspace only box is cleared, the 
entire design is checked independently of the area that is visible in the workspace. 

3. In the Conduct checks area, select the On visible objects and layers only box, to check 
visible objects only. Clear the On visible objects and layers only box to check everything 
in the design, even if an object or entire layer is invisible.  

Tip: Change the visibility of objects and layers using the Display tab on the Options 
dialog box. 

4. In the Check design for area, select the Object Clearance box. 

5. Make sure the Net against all objects, Keepout restrictions, and Objects against board 
outline boxes are selected. Clear all other check boxes. 

6. Click OK to exit the Options dialog box. 

7. To check the design, click the Verify Design button  on the Design Verification toolbar.  

Alternative: Click Verify Design on the Tools menu.  

Viewing spacing errors 

The design will contain errors. Examine the errors using one of the following methods: 

 Use the error report, displayed in the Errors tab of the spreadsheet window, to get 
information about errors found. 

 On the Selection Filter toolbar, click the Errors button  , select an error marker in the 
design, right-click, and click Properties. The Error Properties dialog box appears. 

You can use SailWind Router placement and routing tools to correct the errors. 

When finished, do not save a copy of the design. 

You completed the design verification tutorial. 
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